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1 Introduction 

1.1 Versions of the document 

This is the version 2.5 of the anyQuery  manual. The screenshots are updated to the current 
version 2.5 and the new functionality description are added. 

In the version 2.3 of the manual, the screenshots are taken from the program version 2.2.0. 
They may be different from higher versions. The functionality has been changed  or enhanced 
in some places. 

The second version of the manual for anyQuery  it’s based on version 2.0.10. Quite a lot of 
new functions have been integrated into anyQuery , so there was the need to completely 
rewrite this manual. Take a look at ����������	��		
�
���
������
���  for an overview of new 
functions and changes to prior versions. 

1.2 Glossary 

Grid dialog element to display and edit data by columns and rows. 

Combobox dialog element to choose from a list which drops down for selection. 

Checkbox dialog element to set or reset an option. 

Tab dialog element to categorize control elements in a window..  

.udl-File  data Link File to define an OLE DB connection. 

drag und drop a method to move objects with the mouse on the screen. 

 

2 Purpose and Overview 

2.1 Purpose of anyQuery 

anyQuery is a special tool to work with all  different kinds of databases. 

Because the developer team of PLANWARE frequently does database development, real 
soon a tool became necessary in order to simplify the work with databases. Extensive 
investigation brought up only some poorly performing tools or excellent ones like the 
QueryAnalyser of SQL-Server, but this one is bound to SQL-Server. 

By and by anyQuery was developed according to the requirements we encountered each day.  
Most important was the possibility to work with many different databases like SQL-Server, 
Oracle, DB2 or MS Access (which is well-known as an eager producer of parenthesis within its 
queries...). 
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2.2 Overview of this document 

In Chapter ����������	��		
�
���
������
���  you will get a short overview of the changes and new 
functions in comparison to prior versions. 

In Chapter �����
������	������������
�������� anyQuery is described with its features and system 
requirements. For restrictions and known bugs please refer to the Readme textfile. 

In Chapter ���
����
�����������  instructions how to register and activate anyQuery . 

In Chapter ��������������  the user interface of anyQuery and its functions are described in detail. 

In Chapter ����
����
�����������  all functionalities of anyQuery are described in the order of  
common workflow. 

In Chapter �����
���  you will get some useful links to SQL and database resources.  

 

3 Changes and additional Functions 

3.1 New or enhanced Functions 

·  simple report writer 
·  session logging in one window and gridview 
·  transaction processing 
·  search and replace in the SQL editor 
·  working with multiple scripts 
·  comment and uncomment row 
·  increase/reduce line indent 
·  sorting, grouping, group footers 
·  a clear user interface 
·  pick lists 
·  enhanced DDL commands with database specific type list 
·  new database explorer 
·  new install routine 
·  enhanced database support (MySQL,…) 

3.2 Changes you should know 

Version 2.3 compared to previous versions: 

normal one line comments starts with //  
// this is a comment  
the old style comments with /* ... */  can span more than one line. 
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4 Functions and System Requirements 

4.1 Functionality 

·  access to different databases by udl-files 
·  english and german version 
·  syntax coloring 
·  creation of SQL queries and scripts with SQL builder 
·  command line parameters for batch processing 
·  database explorer 
·  simple report writer 
·  session logging 
·  transaction processing 
·  search and replace in SQL editor 
·  working with multiple scripts 
·  sorting, grouping, group footers 
·  a clear user interface 
·  pick lists 

4.2 System Requirements 

anyQuery  runs on Windows 98, Windows NT 4.0, Windows 2000 and Windows XP. 

4.3 Restrictions 

For all Windows platforms, except Windows XP, the „DataAccessPack 2.7“ is needed. This 
database package can be downloaded from the Microsoft web site www.microsoft.com/Data 
for free. 
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5 Registering anyQuery 

5.1 How to register 

To get rid of the message boxes telling you have to register your version of anyQuery and 
order a license key from http://www.planware.com. Having received your license key please go 
to the ? menu (help menu) and click on the About anyQuery  item to open the about dialogue.  

 
Fig. 1 about dialogue 

Within the about dialogue click on the Register Program  button to open the Enter 
Registration Key dialogue to fill in your license key. 

 
Fig. 2 Enter Registration Key dialogue 

The license key is in the form of 4 groups of 3 characters separated by a dash. Having entered 
the license key click on the OK button. After restarting anyQuery you should no longer be 
prompted to register. 
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6 User Interface  

6.1 anyQuery and Batch Processing 

For batch processing anyQuery also can be invoked from the command line. For this you can 
use the following parameters: 

database connection  /INI:<path to udl-file> 
user     /USR:<username> 
password   /PWD:<password>  
query    /QRY:<path to qry-file> 
run  immediately  /RUN 
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6.2 Main Window and Menu Bar 

 

 

 

 

 

 

 
Fig. 3 anyQuery User Interface 
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6.2.1 Menubar 

 

Fig. 4 Menubar  

6.2.1.1 File Menu 

 

Fig. 5 File Menu  

Within the File Menu  you will see the following menu items: 

New Database Connection  for creating a new database connection (see �����
����� ���!����
�������
�� ). 

Edit Database Connection  for editing an existing udl-file (see "�	
��
����� ���!�����������
�� ). 

Open Database Connection  connects to database via the predefined udl-file (see #$��
�����
 ���!�����������
�� ). 

Open Recent Connection  opens a Submenu with the last used connections  (see #$��
�����
 ���!�����������
�� ). 

For detailed description and examples of the following items see ����
����
�������
�����	����
$�� . 

New SQL Script  creates an empty SQL worksheet. 

Load SQL Script  loads a saved query definition (.qry) to the SQL editor. 

Close SQL Script  closes the active SQL worksheet. 

SQL Script Save  saves the active query with the assigned name. 

SQL Script Save As  lets you assign a name and location where to save it to the query. 

Open Recent SQL Script  opens a Submenu with the last used scripts. 

Settings  let you modify some path and editing preferences (see ����
���� 
�
���� ) 

Exit  quits an anyQuery session. 
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6.2.1.2 Edit SQL Menu 

 

Fig. 6 Edit SQL Menu 

Within the Edit SQL Menu  you will see the following menu items: 

Cut  text in the SQL Editor 

Copy  text in the SQL Editor 

Paste text in the SQL Editor 

Ucase converts the content of the SQL editor to upper case. 

Delete Tabs  deletes all tabulators from the content of the SQL editor. 

Format SQL  formats the content of the SQL editor. 

Delete Querytext  deletes the content of the SQL editor without saving any changes. 

Comment Row  adds a comment sign // to the beginning of each selected line 

UnComment Row  removes a comment sign // from the beginning of each selected line 

Increase Indent  increases the indent of all selected lines 

Reduce Indent  reduces the indent of all selected lines 

Auto Syntax Coloring  colors keywords, comments and operators word by word. 
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6.2.1.3 Query Menu 

 

Fig. 7 Query Menu 

Within the Query Menu  you will see the following menu items: 

Execute Query  executes the actual query (see �����
���%&����� ), as a shortcut you can also 
press F2. 

Stop Query  cancels a running query (see �����
������$ ), as a shortcut you can also press F3. 

Build Update  builds an Update-Set statement for the currently selected table, all key fields 
included and the selected row from the result grid. 

Build Where  builds a Where-Statement for the currently selected table, all included key fields 
and the selected row from the result grid. 

Build Join  builds a simple Join-Statement for the currently selected tables. 

Insert Fieldlist  inserts all selected Fields into the active SQL worksheet. 



6.2.1.4 Resultgrid Menu 

 

Fig. 8 Resultgrid Menu 

Within the Resultgrid Menu  you can see the following menu items: 

Layout settings  customizes the resultgrid layout for the Screen- and Printerview (Report). 

Allow Column Sorting  enables sorting of data in the result grid (see '�

	
�������$��� ). 

Allow Column Grouping  enables grouping of data in the result grid (see '�

	
�������$��� ). 

Show Group Footer  displays a group footer in the result grid at the end of each data group 
(see '�

	
�������$��� ). 

Show Record navigation  displays buttons for record navigation at the bottom of the result 
grid. 

 

Fig. 9 record navigation 

Card View  switches the grid to a card file view. 

Fit All Columns  resizes all columns to fit best to the width of the resultset data (see '�

	
�����
��$��� ). 

Show Row Headers  shows a record selector for each row when enabled.  

Show Gridlines  shows grid lines when enabled. 

Report Style  shows record selectors and column headers in a report style when enabled. 

Print  Settings  opens a dialogue to configure print settings (see '�

	
�������$��� ). 

Print  preview  generates a print preview of the result (see '�

	
�������$��� ). 

Export  as stores the query result into a text-, XML- or (X)HTML- file (see %	
�
���������� ). 
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6.2.1.5 DBInfo Menu 

 

Fig. 10 DBInfo Menu 

Within the DBInfo Menu  you will see the following menu items: 

All Tables  creates a text file of all table names of the active database. 

All Fields  creates a text file of all field names of the active database.  

All Views  creates a text file of all view names of the active database.  

All View-Fields  creates a text file of all view field names of the active database. 

All Index-Fields  creates a text file of all index fields names of the active database. 

All Recordcount  creates a text file with the record count of all tables of the active database. 

The text files are created in the anyQuery directory. These files can also be imported into  
MS Word or MS Excel. 

For a detailed description of this items see %&$���
��� ���!������������
�� . 

6.2.1.6 "?" Menu 

 

Fig. 11 ? Menu 

In this menu you will find the About dialog  with some version information and a link to our web 
site www.planware.com.  

Please feel free to contact us and tell us your suggestions about anyQuery. 

In an unregistered version of anyQuery you will also find a button to register this software. 

Further more you will find the online help documents in this menu. You can also get there by 
pressing F1. 
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6.2.2 Functions of anyQuery 

You will find some of the more often used functions on the Toolbar. 

 

Fig. 12 Toolbar 

6.2.2.1 Function Open 

The Open button  will load a stored query into the SQL editor. There are several extensions for 
query files, except reports they are all interpreted the same way. A report consists of two files, 
the query *.qry  and a report definition *.bin . 

6.2.2.2 Function „Connect“ 

The „Connect button “ opens a new database connection using a .udl File. 

6.2.2.3 Function „New“ 

The „New button“  opens a new  SQL-Editor Tab window 

6.2.2.4 Function Save 

The Save button  will store all changes and modifications of your query. 

6.2.2.5 Function SaveAs 

The SaveAs button  stores the displayed query under a different name in the selected 
directory. 

6.2.2.6 Function Delete Query 

The Delete Query button  will drop the currently displayed content of the SQL-editor without 
saving any changes. 

6.2.2.7 Function Execute 

The Execute button  runs the Query. Press function key F2 as a shortcut for running queries. 

6.2.2.8 Function Stop 

The Stop button  interrupts the currently running query. Function key F3 serves as a shortcut. 
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6.2.3 Table and View Area 

 

Fig. 13 table and view area 

In the table and view area you will find several elements to browse, filter and select tables 
and views from the set of available objects in your database. 
The second element from the top is a combo box from which you can pick a table, the table 
will immediately be shown in the list box below. 
The filter box  on top allows you to filter a subset of all tables or views by a portion of their 
names. You can e.g. filter a certain database owner. After changing the filter you have to 
click the Refresh button  to reload the combo box. 
 

 
Fig. 14 System Objects 

By choosing the System Objects  option system tables are additionally loaded to the 
tables/views  combo box . 

 

Fig. 15 table/view list 

A double-click on one of the listed tables/views will insert the table/view name into the SQL-
editor right to the current cursor position. 
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6.2.4 Field Area 

 

Fig. 16 field area 

Right above you can see the field list , where all fields of a selected table are listed. anyQuery 
will display the fieldname, the datatype, the field size, a statement for null ability and some 
information about the index. 

A double-click on one of the listed fields will insert the field name into the SQL Editor  right to 
the current cursor position. 

You can select more than one field and insert this list of fields by clicking on Insert Fieldlist  
button. 

By choosing the Long Names  option the owner and table names are prefixed to the field 
name when inserted to the SQL-editor. 

The Indexname  column  gives you some information about which fields belong to which index 
(indexname) and the number shows you in which order they appear in the database. 

6.2.5 SQL-Commandbar Tab 

 

Fig. 17 SQL-commandbar 

The SQL-commandbar  with the SQL-keywords and the operators will simplify the creation of 
a query and will insert simultaneously neat paragraphs. 

6.2.6 Find/Replace Tab 

 
Fig. 18 find dialog 

The find dialog tab  is useful for long scripts to search for words or substrings. 
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The Whole Word  option  finds only phrase which matches on the words boundary, substrings 
will not be found. 

The Match Case  option  does a case sensitive search. 

The Start  button allows you to start the search from the beginning of the script. The Next 
button  starts the search from the current cursor position. 

The Replace Button  opens another window, where you can input the search/replace- text. 

 

6.2.7 Query Options Tab 

 
Fig. 19 query options 

All options mentioned here are dependent on the database or database driver used so they 
might not work at all or function differently when applied in your database environment. 

The query options  tab allows you to set some useful options for all queries and handle 
database transactions. 

The Timeout  property  sets the maximum execution time for a query, if the query exceeds this 
limit it will be cancelled. 

The Max Records  property  sets the maximum number of records. The number of records 
that will be retrieved is always less or equal to this value. For displaying the max. number of 
records of a select query, put in a “0” into the Field and leave it by pressing TAB or ENTER. 

The three transaction buttons  gives you the possibility to group several queries to one 
transaction and commit or rollback the changes. 
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6.2.8 DDL-Commandbar Tab 

 
Fig. 20 DDL- Commands 

The DDL-commandbar  simplifies the creation of data definition statements. 

All command buttons  will at least display a useful frame if no Tables are selected for this 
statement. 
The datatypelist contents the datatypes which were supported by the database. Doubleclick 
to insert the datatype name into the SQL-editor. 

6.2.9 Parameter-Commandbar Tab 

 
Fig. 21b Parameter 

The Parameter-commandbar  shows the parameters in the SQL-script.. 

In the field behind the Parametername, you can input a value which were used at script 
execution. 

new creates a new parameter tag in the SQL-script. 

  

6.2.9.1 Create new parameter 

 
Abb. 21c create new parameter dialog 

In the field Name you can name your parameter. With type you set the parametertype 
(String,Integer,Double,Date..). With size you can give String types a input length limit for 
parameter values (see Fig. 20b above). 
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6.2.10 SQL-Editor 

 
Fig. 22 SQL-Editor 

Within the SQL-Editor  you can create your queries. You can load already stored queries for 
modifications. 

You have the possibility to format the displayed content and to color the keywords (see %	
�
�����
����� ). 

The editor is able to handle more than one query at a time, you can switch between the loaded 
queries by clicking on the appropriately named tab at the top of the editor area. In the right/top 
corner of the main window you find a little button with a cross to close the active query. 

6.2.11 Result Area 

The result area  is at the bottom of the anyQuery window. 

 
Fig. 23 Result Tab 

The result tab  shows a grid to display the results of your queries (see �
�(�)���������������
��������� ). 

You can sort the result (see �����"��� ) and group the view (see *���$�"��� ) 

For processing in other tools like MS Excel transfer a part or the entire result into a MS Excel 
sheet via “drag & drop”. 
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6.2.12 Layout settings 

 
Fig. 24 Layout Tab 

The layout window  allows you to create simple printable reports. There are several functions 
to align and format values even some simple aggregate functions like summary are 
supported. 
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6.2.12.1 Session Tab 

 
Fig. 25 Session Tab 

The session tab  shows a list of processed queries for the current connection with execution 
time and the number of rows and columns in the result set. It also logs any errors. Furthermore 
you can copy statements from here to the SQL-Editor . 

The session log will be saved in a textfile named ‘anyQuerySession.txt’ after you quit the 
program. 
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6.2.13 Helpful result formatting by popup menu 

By clicking the right mouse button at the result area, a popup men appears. There you can 
quick set some resultgrid formats.(see also Chapter ‘Resultgrid Menu’) 

 
Abb. 26 Result formatting 

Sorting:  
By clicking on the Allow Column Sorting menu  you can enable and disable the column 
sorting function. When the function is enabled you can sort a column by clicking on the column 
header. Every click on the column header toggles between ascending and descending order. 

Grouping: 
By clicking on the Allow Column Grouping menu  you can enable and disable the column 
grouping function. When the function is enabled you can group the data by one or more 
columns. Drag a column to the area above the grid. The grid will show the group header as 
shaded rows with + or - in front of it to expand or collapse the data portion. 

Show group footer: 
By clicking on the Show  Group Footer menu  you can enable and disable a group footer for 
each group. The group footer can display a result of an aggregate function which you can 
define in the layout tab for each column. 
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6.2.14 Statusbar 

 
Fig. 27 Statusbar 

After you have chosen a database connection via “File Menu / Open Database Connection”, 
anyQuery  will display the user name and the name of the database in the left portion of the 
statusbar . 

The second field of the statusbar  displays the execution time of the query. 

The middle portion of the statusbar  displays the number of records of the executed query 
shown in the result grid . 

The right most field of the statusbar  displays the actual line and column number of the SQL-
Editor . 

6.2.15 Settings Dialog 

 
Fig. 28 Settings Dialog, Path Options 

In the settings dialog  you can define standard pathes for UDL files and queries. Besides that 
you can assign a UDL file which will be loaded at startup. The Clear button  resets this so no 
connection will be made automatically at startup. 
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6.2.15.1 EditTab 

 

 
Fig. 29 Edit Tab 

Within the edit tab  you can make some font settings for the SQL editor . 
 

6.2.15.2 Language-Tab 

 
Abb. 30 Language-Tab 

Within the language-tab  you can select the User Interface language for anyQuery  . At the 
moment you can choose between German and English. To activate the language selection 
save the settings and restart the program.  
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7 Working with anyQuery 

7.1 Preface 

This chapter will explain how to manage some basic tasks with anyQuery. To do so we will use 
a sample database of Microsoft Access called NORDWIND.mdb  or NWIND.mdb . It is not 
absolutely necessary to have it to follow these examples you can use a different sample 
database as you like. 

7.2 Database connection 

Database connections are stored as .udl  files so you only need to setup them once. 

To organize your connections you can set a default path in the settings dialogue.  Select a 
path under Standard UDL-Path  and your .udl  files will be opened from and saved into this 
folder. 

7.2.1 Creating a Database connection 

To create a data base connection choose the File menu . From the submenu select New data 
base connection  and the dialog Data Link Properties  will appear. 

 

Fig. 31 Window for creating a data link file 
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From the Provider Tab choose the OLE DB-Provider and press the Next Button  to switch to 
the Connection  Tab. Select the file of the database that needs to be connected or fill in the 
parameters of the provider. Username and password are optional. Click the Test Connection  
button  to immediately check for a proper working connection (username and password are 
mandatory). 

To use the new connection click the Open Database Connection  submenu  in the File menu  
and choose the .udl-file  from the dialog. 

7.2.2 Modifying a Database Connection 

Choose the File menu  and select the submenu Edit Database Connection  for editing the 
database connection of a stored .udl-file . 

7.2.3 Opening a Database Connection 

To work with anyQuery you have to connect to a database first. Open a stored .udl-file  from 
the File menu and select submenu Open Database Connection . You can also choose a 
connection from the Open Recent Connection menu . 

7.2.4 Creating a Connection for NWIND.mdb 

Select New Database Connection item  from the File menu . Select one of the Microsoft 
Access OLE DB drivers  from the list and click the next button . Select the database location 
and click the OK button . Enter a name for the new udl-File  in the next dialogue and click the 
save button . Now you have successfully created a new database connection. 

7.3 Working with Queries and Scripts 

There is no difference between queries and scripts except that a script is composed of several 
queries which are separated by a semicolon. We prefer the extensions .qry  for queries, .sql  
for scripts and .ddl  for data definition statements, but there is no need to do so. anyQuery 
recognizes statements as a script when there are at least 2 semicolons in it. You should not 
end a normal one statement query with a semicolon because this will most probably produce 
an error. A script is executed statement by statement and you will get the result printed in the 
Session Tab . Scripts can not include SELECT queries  they are only for action queries . The 
execution of a script will not be stopped if an error occurs, if you would like to preserve your 
data integrity you can set a transaction  before you click on the Excecute button , watch the 
logging and commit  or rollback  afterwards. 

Because there is no difference between queries and scripts from now on we will only talk about 
queries. 

There is no limit to the number of queries to be open at the same time in anyQuery. 

To create a new script use the New SQL Script  menu  or the shortcut ALT+N. As long as you 
don't save it the query will have a name like *New SQL - 01. You can select a query you want 
to work with by clicking on the corresponding named tab below the SQL-Editor . To close it, 
click on the small cross in the left corner, if you made any changes to the query you will be 
asked to save it. 
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Normally it makes sense to organize your queries in folders and subfolders, to do so use the 
settings dialog  and set the Standard Query-Path  to a folder you would like your queries to 
be stored in. If you will later on open a query from a different location anyQuery will remember 
this folder for the rest of the session for opening  and saving operations. 

Queries are stored as plain text, you can edit them within every standard editor or execute 
them with any standard SQL processor. 

We will use the database connection for the NWIND.mdb we have created before for our next 
steps. Choose Open Database Connection  from the File menu  and select the corresponding 
file. After a few seconds you will see the connection information in the left corner of the Status 
Bar. 
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7.3.1 Editing a Query 

To compose your queries you can simply type your statements into the SQL-Editor . Much 
easier it is to use some of the facilities of anyQuery like the tables list  and fields list  and the 
SQL Command Bar .  

Now please select the customers  table from the tables combobox , it will immediately appear 
in the tables list . When you click on the customers table entry you will see the field names and 
extended information in the fields list .  

Now select the customers table and click on the SELECT * FROM button  and you will get a 
complete SQL like this: 

 

Click on the Execute button  to execute it, the result will be displayed in the Result Grid  
below. If you think that this is not a useful query - ok, delete it by clicking on the Delete button . 
Now select some of the fields from the fields list , hold down the CTRL or SHIFT key to select 
more than one field, after that click on the SELECT <f> FROM button  and you will get a 
statement like this: 

 

Don't think about the brackets, this is access style and will be omitted when you connect to a 
real SQL database. 

You can also use the Insert Fieldlist  button to insert all the selected fields, but this will only 
insert the fields not the key words. 

Now you can extend your query a little bit, we want to add a WHERE part. Position the cursor 
behind the word customers  in the editor and click on the WHERE button . Double click on the 
field name City  and on the = button . Now type the condition 'London' . You will get this 
statement: 

 

After you have executed it we will see how to perform an update on one of the records. 

Open a new query by pressing ALT+N, you will get an empty worksheet. Select the record 
where the contact name is Ann Devon  and from the Query menu  choose Build Update  and 
the SQL-Editor  will show the following statement: 

 

They only thing you have to do is to fill in the fields and values you want to update. Similar to 
this is the function Build Where , but you will only get the where statement from above. 

Ok, now we switch back to our first query and try to export our result. There are 4 possibilities 
to do so: 

·  print a report 
·  use drag and drop to export it to another OLE aware application like EXCEL 
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·  export it as a text file with a predefined field delimiter 
·  export it as XML file (this is a non-standard XML format, maybe Microsoft will update 

their ADO library sometime) 
To print a report you only have to choose Print Preview  from the Resultgrid menu , there you 
have some options to setup the page and print everything. anyQuery includes also a small 
report writer which will be discussed later. 

Drag and Drop is simple, only select the rows from the record set you want to export and drag 
them (hold the left mouse button) to your preferred application (Notepad doesn't work).  

To export the whole record set to a text file click on the Export As... Text-File  item  in the 
Resultgrid  menu , choose a filename and click the Open button . When the export is finished 
you will get a message box. 

The standard field delimiter for text export is a tab stop , but you can configure it in the 
anyQuery.ini  file  in the anyQuery program directory. The keyword is FldDelimiter , if it is not 
present the tab stop will be used. To define another delimiter only add/modify the FldDelimiter 
entry in the Settings  section of the ini file . The value of FldDelimiter  is the ASCII code of the 
character. If you for example want to change the delimiter to a semicolon you should have a 
line like 

FldDelimiter=59  

in your anyQuery.ini file . Changes to the ini file  will only take effect after the next start of 
anyQuery. 

The last possibility is to do a XML export. Click on the Export As... XML-File  item in the 
Resultgrid  menu , choose a filename and click the Open button . After the export has finished 
you will get a message box. 

 

Now to some additional features: comments and formatting. 

In every query or script you can use comments at any position. Besides documentation 
comments are good for testing statements.  A comment starts with a // and spans one line. 

 

To comment or uncomment a whole block of text you can use the Comment Row  function  or 
UnComment Row  function  from the Edit SQL menu . You can also use the shortcuts ALT+C 
or ALT+U. To do so mark the region of text and click on the menu item or use the shortcut, the 
color of the marked text will change to green. 

The function which colors your text is named Autosyntax Coloring  and can be switched on 
and off in the Edit menu . This makes sense with long scripts in which the coloring function can 
consume a noticeable amount of time. 

To debug statements which were generated by applications you can paste this often 
unformatted SQLs to the SQL Editor  and use the Format SQL  function  from the Edit  menu  
to let anyQuery do the job of making it more readable. This SQL for example  
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will be formatted as 

 
Keywords and field lists will be made up and tab stops will be inserted. 
 
To use your query build with anyQuery in any program code it is often useful to convert it to 
upper case and replace the tab stops with spaces. You can achieve this with the Ucase  
function  and Delete Tabs  function  from the Edit  menu . 
 
You can indent blocks of text yourself using the Increase Indent  function  and Reduce 
Indent  function  from the Edit  menu . You can also use the shortcuts ALT+RightArrow  or 
ALT+LeftArrow . To do so mark the region of text and click on the menu item or use the 
shortcut and the indent of the whole text block will be increased or reduced. 
 
To change the font style of the SQL Editor  open the Settings  dialogue  from the File  menu  
and switch to the Edit  tab . Now you are able to change the font  and the font size . Keep in 
mind that a TrueType font will mess up the formatting of the SQL Editor . 

7.4 Building a report 

For this paragraph we will use the following statement as an example how to sort and group 
the result and build a report: 

 

When you execute this query you will get a resultset similar to this: 

 

Because the resultset is very small we can do some very common tasks easily without 
changing the query: 
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To sort the resultset ascending by ProductName click right mouse button and choose the 
Allow Column Sorting  menu  to activate the sort function and on one of the column headers - 
here the ProductName - and the column will be sorted ascending. If you click once more on 
the same column header  the sort order will be toggled to descending and so on. The small 
arrow  in the column header  points at the position where you will find the smaller values - 
bottom or top of the list. 

 

Now you can click on the price to find out the smallest and the highest price. 

The Allow Column  Grouping  menu  and Show  Group Footer  menu  allow you to group the 
resultset by the values of a specific column and display a footer for calculations at the bottom 
of each group. To do so, choose the the Allow Column  Grouping  menu  and a box in the 
upper region of the grid appears. Click for example on the CategoryID, drag it to the box and 
drop it there. The resultset will be grouped by the  CategoryID and dark bars will highlight the 
groups. The group header has a small button  with + or - sign to expand or collapse the 
according group. 

 
Now choose the Show Group Footer  menu  and dark group footers will be displayed for each 
group. For the group footer you can choose from a limited list of aggregate functions : 
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function description 

Count Displays the count of records in a group. 

Sum Displays the sum of values in a group for the column. 

Average Displays the average of the values in a group for the column. 

Min Displays the minimum value in a group for the column. 

Max Displays the maximum value in a group for the column. 

Standard Dev Displays the standard deviation in a group for the column. 

Value Count Displays the count of records with non-null values in a group for 
the column. 

 

Imagine, we want to make a report with the number of items we have in stock for each group 
and what the average price. To prepare the report choose the Layout settings menu  and you 
will see all the parameters for the report in the layout window: 

 
The Data Field  column shows you the field name and we will reference on that and on the 
column header. Ok, we will go through the columns from left to right and explain what to select 
or fill in for this report. 
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In the Column  column  fill in  

 Product No  for ProductID 

 Product  for ProductName 

 Price  for UnitPrice  

 Units  for UnitsInStock 

In the Aggregate  column  select 

 Average  for UnitPrice 

 Sum for UnitsInStock  

In the Headeralignment  column  select 

 Center  for UnitPrice  

 Center  for UnitsInStock 

 

In the Visible  column  unselect 

 CategoryID  

In the Group Prefix  column  fill in  

 Category  for CategoryID  

In the Total Prefix  column  fill in  

 avg. Price  for UnitPrice 

 sum  for UnitsInStock  

For the changes to take effect, please click the Save button . Also check the Hold layout 
checkbox , this will hold the layout even if you execute the query again. If you leave the Hold 
layout checkbox unchecked the Result Grid  will be initialized with default values and your 
layout will not be saved/be gone.  

When closing the layout window you will see the changes we have done in the grid. 
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There are three possibilities to adjust the column width: 

1. in the Layout Window : set the value of the column Width  for each Data Field  

2. in the Resultgrid : double click on the grid line between two columns to automatically fit the 
column width to the contained data 

3. in the Resultgrid : select Fit All Columns  from the Resultgrid menu  to fit all columns to 
the width of the grid 

We can now save and print our small report. For saving use the Save As button  and select 
the filetype Report  and fill in a name for it. A Report consists of two files:  

·  the query with the extension .rpt  
·  the report definition with the extension .rpt.bin  
If you would like to switch between queries and reports during your anyQuery session, you 
better save report and layout to a file, because otherwise your layout will get lost when 
switching to another query. 

Before printing we will take a short look at the Print Settings  and the Print Preview .  

 
Fig. 32 Print Settings dialog 

Within the Print Settings dialog  you can define the text for the left, mid and right headers and 
footers of your report. Additionally the following functions can be used to display page numbers 
and date in the report. Use a hash in front of the function name. You may also select a 
separate font for headers and footers by using the Font button . The middle section of the 
dialog enables you to setup the page layout . 
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function description 

PageNumber current page number 

nPages total number of pages 

Date current date and time 

 
The Standard Settings button  sets useful values for all options and you will get a layout 
which will fit for most purposes. 
To save your changes click the Save button , but don't forget to save the whole report to a 
file again, otherwise your changes will be lost, when you close the session or uncheck the 
Hold layout  checkbox . 
 
From the Resultgrid  menu  select Print Preview  to see your report as it will appear printed. 
 

 
 
Within the print preview click on the printer symbol  to print the whole report - at the 
moment it is not possible to print ranges or single pages. 
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7.5 Exporting Database Information 

anyQuery has 6 functions to export Information about the actual database to text files. The 
resulting text files are tab stop delimited and will be written to the anyQuery program directory. 
These functions are pooled in the DBInfo  menu . The following table lists the menu items, the 
name of the export file and gives a short description of each function. 

menu item export file description 

All Tables Tables.txt provides a list of all tables in the current database 

All Fields Fields.txt field names, datatypes and properties of all fields in all 
tables 

All Views Views.txt provides a list of all views in the current database 

All View-Fields ViewFields.txt field names, datatypes and properties of all fields in all 
views 

All Index-Fields Indexes.txt index type and index fields of all indexes in the current 
database 

All Recordcount Recordcount.txt record count of all tables in the current database 
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8 SQL-Links 

8.1 Links for Introduction, Help and Database Provi der 

Homepages Database Provider 

MySQL: http://www.mysql.com/ 

ORACLE: http://www.oracle.com/ 

IBM-DB2: http://www-4.ibm.com/software/data/db2/ 

Microsoft SQL Server: http://www.microsoft.com/sql/default.asp 

Mini SQL: http://www.hughes.com.au/products/ 

SQL Tutorials 

http://www.dcs.napier.ac.uk/~andrew/sql/ 

http://www.w3schools.com/sql/default.asp 

http://www.sqlcourse.com/ 

http://www.sqlcourse2.com/ 

German Tutorial for MySQL: http://www2.rent-a-database.de/mysql/ 

DB2 – Manuals with SQL-Reference 

http://www-4.ibm.com/cgi-bin/db2www/data/db2/udb/winos2unix/support/techlib.d2w/report 

Link Portal 

http://www.sql.org/ 

SQL-Magazine 

SQL-Server Magazin: http://www.sqlmag.com/ 

SQL-Books 

Markt+Technik: http://www.mut.com/leseecke/leseecke.asp 

http://ourworld.compuserve.com/homepages/Graeme_birchall/HTM_COOK.htm 

 


